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 About this Tutorial

This Tutorial pretends to be an application introduction, specially thinking in users that have not
got any experience in the CAD World, but it will be useful to users coming from another CAD 
platforms, specially    AUTOCAD(*). In this Tutorial we develop an elemental example. We do 
not pretend to show all TECNOWIN possibilities, only the more elemental commands to start.
      In any case, we insistently recommend you to waste some minutes of your time reading the 
Tutorial. It will not take you much time and it is sure that it will be useful in spite of its apparent
simplicity.



 The Working Environment

        When the application starts, a document will be opened by default (its name: TWIN1). If we
wish to open an existent drawing we must go to the File Menu and pick the Open command (or 
pick the appropriate button in the Up ToolBox/ToolBar). If we wish a new document we must go 
to the File Menu and pick the New command (or pick the appropriate button in the Up 
ToolBox) .    In our case we are going to work with the default drawing (or document, we will 
use both words equally well) TWIN1. This doc name appears in the working window which we 
can MAXIMIZE to work comfortably and use the largest working area.
 A Menu appears with all the application options:

      Before we go on with the Tutorial, we will incidentally say that if we close the TWIN1 
document and there is not another open document, another Menu appears with only two actives 
submenus: File and Help

 As we are moving with the mouse on the window we see that coordinates (ever in meters, 
because the program works in meters and sexagesimal degrees) appear in one of the lower 
screen panels. If we move to the up right corner we can see the largest drawing format we can 
afford. Then, one first question come to our mind: What would happen if our drawing size is 
larger than this? So we must enlarge our working area. We will do this with the Zoom Scale 
command.
      Other important point: TECNOWIN works in REAL SIZE. So we MUST NOT WORRY 
about Scale drawing. We draw in real size (meters) and ONLY when the printing moment arrives
we apply a paper size and a scale to our drawing. Well see further this concept .
        The lower panel is subdivided in four panels with the following functions: 

        - The lower left panel shows basic information about the option of the menu    we are. In the 
case we pick any option (or command), this panel will show either the application questions or 
TECNOWIN comments about that command.

      - The second lower left panel shows the ORTHO parameter state (Orthogonal working 
mode). Activate (ORTHO ON) is the default mode. Deactivate show ORTHO OFF. For toggle 
ORTHO ON/ORTHO OFF we must pick the ORTHO button in the Up ToolBox.
            With the ORTHO command activated every line well make will be obliged to draw at 
0,90,180,or 270 degrees. It can be comfortable in a lot of cases. With the Ortho command 



deactivated we can draw at any plane directions.

      -    The third lower left panel shows the point coordinates if we are in the drawing area or 
basic information about the buttons in the different TOOLBOXES.

        - The fourth lower left panel (first by right hand) shows the current layer. Well see the layer 
concept later on. It is in relation with the following fact: Not all the objects that we draw will 
have the same properties (COLOR for example). Well put objects into groups. These groups are 
the LAYERS. We can say in other words: A LAYER has a group of objects. We decide about the 
layers name and the layers color, but its necessary to have at least ONE layer. This is the LAYER
BY DEFAULT and we need it in the beginning to draw. All the objects we draw will go to that 
layer. The TECNOWIN default layer has the following name: TW. That layer name appears in 
the lower right panel. 

          We can also see a group of buttons in the screen up part. The graphics buttons are in row 
and each button has got an associated command. Well call them UP TOOLBOX. It can be 
interpreted like the Application TOOLBAR.

 We can see another group of buttons in the right hand of the screen. They are in two columns. 
Well call them TECNOWIN-I ToolBox .
      There are another ToolBoxes in the Application. They are not visible in the start of the 
program but you can activate them in different ways. They have got the following names: 
TECNOWIN-II and TECNOWIN-3D. They are in the Windows Menu. Youll find another 
ToolBox if you acquired either the Architectural or Cartography Extensions for TECNOWIN. 
The ToolBoxes are very useful when working because their buttons are very close to us. Their 
buttons have the principal TECNOWIN commands.
      
      We must know where we are at this moment. Are we ready to make our first drawing?
      Well see it in the following chapter.





 My First Drawing

We want to draw an elemental drawing with the following dimensions:

                The first thing we can think is ... Where can we draw the first vertex?... and Which will 
be the first vertex to draw? The answer is IT DOESNT MATTER. The reason: We only will need
define one point by its absolute coordinates in very little cases (for example in Topography).
      In most of the times we must make a drawing with a real size and print it with a paper size 
and Scale. The drawing position, paper size and Scale DONT MATTER for the program. Well 
give them later without problems. We are saying that the position for our vertex are not relevant.
      We start with the V1 vertex (we could start with the V2, V3 or V4 vertex in the same way). 

We go to the Draw Menu and pick the Line command (or the button in the ToolBox:  ) to 
draw a line between V1 and V2. We put the mouse in a point of the drawing area (its position 
dont matter) and pick. Well get V1 in this way. At this moment when we move the mouse an 
elastic line beginning in V1 appears. Also the question To point: appears in the lower left panel : 
TECNOWIN    asks us for the V2 position, the position of the endpoint of the line. When we 
move to the right hand appears the current point position in the Coordinate Panel. It shows the 
current position in Polar Coordinates, it means, relative coordinates (distance and angle) 
respect the previous point  (V1). For example    D:4.45 A:0, it means: 4.45 meters to the right 
hand (0 degrees) from V1 point. If we move to the left hand we can see something like this    
D:3.56 A:180, it means 3.56 meters to the left hand from V1 (180 degrees). If we move up the 
angle in the panel will be 90 and if we move down 180.    We are assuming that we are in 
ORTHO ON mode.
        In our drawing we must draw a 8.90 meters length line to the right hand. Well move in that 
direction, well see when the number 8.90 is put in panel and pick. Or not? Well, the most expert 
users perhaps could do in that way, but we can do a shot error !... After we pick we can find a 
real surprise !... The length line can be 8.92, not 8.90. Is there another method to pick my point? 
We dont want depend on our skills. That is not serious... YES, of course. The second (and more 
practical) method is the following:
      We go to the Approximation Menu and pick the Reference Dist command. We can pick on 

the button of the Up ToolBox too:    .
        

      



      A Dialogue Frame appears asking for the Distance (Length) value. This value is the real 
length of our line, so we type 8.90 and pick the OK button. It seems there is not any effect, 
because the elastic line follows moving in (right, left, up or down with our mouse), but 
TECNOWIN knows in this moment that we want a 8.90 length line. It only needs to know the 
right direction for drawing our line (right, left, up, down). We must move in the right direction 
(in our case to the right hand) and pick ANY POINT in that direction. Well see    that 
TECNOWIN draws a 8.90 length line to the right hand, as we wanted. The picked point position
DONT MATTER because its only a reference for the right direction.

        We already have drawn the V1-V2 segment. Now well draw in the same way the V2-V3 
segment, keeping on mind that it goes downwards and its length (Distance) is 7.60.

          But when we arrive to V3-V4 we are in trouble. We moved in ORTHO ON mode for 
drawing last lines, but the V4 point is not either straight left or up. Its position is in between. 
How can we define the point? Of course it is impossible with our knowing level.        Even if we 
suppose that we pick the ORTHO button and we put in ORTHO OFF mode, we    can move in all
the directions, but    V3-V4 has got one and only one defined direction.
      We can draw V3-V4 in two different ways:
      - The first way look like the process we followed to draw V1-V2 y V2-V3. We must know 
the V3-V4 angle. In our case its clear: 45 degrees. Were going to the Approximation Menu and 

pick Reference Angle (or the button in the Up ToolBox      ). 

    A Dialogue Frame appears with two options: a) Pick Line. b) Angle. This is a list with any 
angles (45 is one of them), but if the angle was another we can key it with freedom.    We pick 
our angle and pick OK and we can see that we are moving along four orthogonal directions: 
45,135,225 y 315 degrees),    different than conventional (0,90,180,270). We go now to the 
Reference Distance command and type 5.66. We move in our right direction and pick any point. 
We already have got V4.
      - The second method can become familiar to users that have worked with AUTOCAD(*).    It 
consists in typing directly @5.66<135 and press ENTER (But the RIGHT BUTTON of the 
mouse because the ENTER from the keyboard will not work). It means that our point will be put 
to 5.66 meters from previous V3 according to a 135 degrees angle respect to X edge (the polar 
coordinates in distance and angle). The @  symbol means that the specified coordinates are 
POLAR, NOT ABSOLUTES.
          Other similar way consists in typing directly @4,4 and press the right button of the mouse. It 
means that our point will be put to 4 meters along X edge and 4 meters along Y edge. The @  
symbol means that the specified coordinates are POLAR, NOT ABSOLUTES. If we had not put 
the @    symbol in front of 4,4 TECNOWIN would have assumed that the point coordinates were
X=4,Y=4 (in Absolute Coordinates,  I mean, referred to Coordinate Origin 0,0).



          V5 has not any problem, but we move our cursor at 45 degrees (we changed before the 
reference angle to define V4). To come back to 0-90-180-270 degrees we go to Reference Angle 
again and pick 0 as Reference Angle in the Dialogue. There is other way for this propose: We can
pick the another option in this Dialogue Frame: Pick Line. Picking this button TECNOWIN 
asks for picking a line to define the new Reference Angle. The cursor shows the shape for 
SELECT objects. We pick on the V1-V2 line or the V2-V3 line (but not over V3-V4) and well 
see that we can move at 0,90,180,270 (right, up, left, down) degrees again.
          V5 determination is obvious now. Then were not going to repeat here the same process that 
we did for V1-V2.We must draw V4-V5 without problems.
      However, we must end our drawing in V1. We can think in calculate the angle and distances 
between V5 and V1 with our actual knowledge level, but it becomes a new problem. The 
problem is solved if we learn a new thing: How to use a point approximation command for 
defining a new point in the drawing.    I mean:
        TECNOWIN asks for To point: and waits that we pick or define the new point by keyboard.
But the point that we wish is the ENDPOINT of a line object that we have previously drawn 
(V1) . Therefore we go to the button at the TECNOWIN-I ToolBox (at the right hand and 

downwards). The cursor will adopt the Approximation Cursor shape  that looks like a    
sight. We put it close to the V1 point and when V1 is into the sight then we pick.        The line V5-
V1 has been drawn and our V1-V2-V3-V4-V5 polygonal too. Its our first drawing. It seems 
simple but we have learned a lot of things (I hope).

              For writing our work in a file we go to the File Menu and pick the Save As command.
 A Dialogue Frame for writing drawing files appears. The default name is TWIN1.TNT, but it 
can be modified. We can call it FIRST.TNT because is our TECNOWIN first drawing.

      You must have present a thing:  the first time that you save a document (this is our case), you
cannot write the doc with the Save command of the Up ToolBox .You must use the commands    
Save / Save As in the File Menu.

          In the next chapter we are going to draw a vertical line to a defined distance of V1. Well 
make a new layer, change the layer of the line and move the polygonal V1-V5 to one of the 
extremes of the line. Then well    hide the vertical line. Here we go !





 Reference Point. Layers and Colors. Basic Edit 
Commands

    We are going to draw a vertical line. Its 3 meters at the left hand from V1. Then we will move 
the V1-V5 polygonal to the middle point of it.
      The Q1 vertex of our new line is put in a point that dists 3 units to the left hand along the X 
edge and 0 units along the Y edge. For defining Q1 were going to pick the Reference Point 

command. This command is either in the Aprox Menu or in the Up ToolBox     .                         
The REFERENCE POINT  is a Transparent Command, I    mean, we can call it from another 
command. So we can: a) Call the REFERENCE POINT command and then the LINE command  
or    b) Call the LINE command and then call the REFERENCE POINT command. As b) is the 
more complex mode here we go:
      We pick the LINE command. It asks for a point: From point: for we define the start point of 
the line. Before picking a point we go to the REFERENCE POINT command. It asks for a 
reference point. V1 is the reference point in our case. So we pick the ENDPOINT command. We
can go to the INTERSECT command too. Both commands are right, but were going to use 
INTERSECT now. We pick V1 into the sight. We already have our reference point. Now we 
must define Q1: We go to the REFERENCE DISTANCE command and type    3 (its the 
distance between V1 and Q1) and pick OK. We are moving to the left hand from V1. Then we 
pick any point. Q1 is defined. Now Q2 doesnt need explication.

        In a next step we are going to explain the Layer concept again. What is a layer?
 Imagine a drawing a little more complex than ours, with more objects. And were going to use a 
example for better understanding of the concept: Imagine that were drawing our home plane. 
This plane has a lot of different things: walls, doors, windows, furniture and more.    Although we
can draw all the elements and we dont need understand the layer concept, we can see that there 
are very different objects. And we probably wish to draw each object with an identify color. For 
example: walls in black, doors in red, windows in green and so on. These colors are the default 
colors that use the Architectural Extension for TECNOWIN  named TECNOCAD. We can take
some advantages drawing in this way, nor only stetical profits. When we print/plot the drawing 
we can assign a different thick line to a different color. I    mean: Wed like WALLS look like 
WALLS, with the same color (by default), DOORS look like DOORS, with their color and so on.
The idea in our mind has a name in CAD (I    think in all CAD applications): LAYER. Then we 
must have a layer for each group of elements, WALLS, DOORS, WINDOWS.    But: What 
about if we could hide the DOORS layer to see our house without doors or for printing? It would
be a good idea ... I    think. This is another possibility if we have the objects in layers.
          In short: Grouping objects in layers allow us:
                      a) Distinguish a color for the objects group, with two purposes:
                              a-1: Esthetic a-2: For printing / plotting.
                      b) Hide / See  the objects group with two basic purpose: 
                                b-1:If we dont need to work with a layer for a time we can hide it. Well see our 
drawing clearer, with fewer objects. It    permits display only the objects that we really need for
working.
                                b-2: A hiding layer will not appear in printing. It permits us printing any 



planes with any layers combination.
            One step more: 
            If you are not an expert in CAD the following words may look pretty confuse, but here we 
go!
            Its not necessary that all the objects in the same layer have got the same color. Layer 
Objects usually have got the same color, but well need sometimes that some layer objects have
got a different color .(For example we can want they have another thick for printing purpose 
although they belong to the same layer for all purpose).
                When we make a layer, we assign a default color. I mean: All the next objects that we 
draw belong to that layer and will be drawn with the default color.
      But we are free for changing the color to a drawn object for another color and the object 
follows belonging to the same layer. We can change the Line Type (the default Line Type is 
CONTINUOUS Type) for another (DASHED, CENTER, DASHDOT) in the same way.
            Next, we are going to apply the Layer concept to our Tutorial:
                We wish that the Q1-Q2 line belongs to another layer. Well call it OTHERLAYER 
(NOTE.- Please be careful with CAPITAL LETTERS. OTHERLAYER and otherlayer are not 
the same layer for TECNOWIN).
        Weve made the Q1-Q5 polygonal in TW, the default layer. Its default color is BLACK. If 
we wish that the Q1-Q2 object belongs to the OTHERLAYER Layer weve got two chances:
      

              a) We can make the OTHERLAYER Layer before draw the Q1-Q2 line, and we must let 
the Make Current Layer mark on. In this way the new OTHERLAYER layer becomes the 
current layer. I mean, all new objects (like our Q1-Q2 line) will belong to that layer. We can see
the layer name in the lower right panel: OTHERLAYER.
                b)    The Q1-Q2 line is already drawn. Then Q1-Q2 belongs to the default layer (TW), 
but we wish that it belongs to the OTHERLAYER Layer. In this case we must make the new 
OTHERLAYER Layer in first time and then use the CHANGE OBJECT LAYER command to 
change the Q1-Q2.
              In both ways -a) or b)- we must explain how the new OTHERLAYER Layer is made and 
how we assign a color for it. If we are following the b) way we must explain the way to 
CHANGE the LAYER of a drawn object too.
              * For making a new layer we must pick the NEW LAYER command (Status Menu, 
Layers SubMenu) or pick the button in the Up ToolBox. A Dialogue Frame appears and we enter:
                - The Layer Name (be careful. Perhaps there is another layer with the same name). The 



layer name is OTHERLAYER in our case.

    

            - Pick the COLOR button for assigning the DEFAULT COLOR for the objects that will 
belong to this layer. Our layer color is the RED color. 
              - Let put the mark in Making Current Layer if we want that the new Layer was the 
Working Layer, I mean : All the new objects will belong to that layer until we change the 
Working Layer with the CURRENT LAYER command.

              * For changing the object Layer we must pick the CHANGE LAYER command (Edit 

Menu, Change SubMenu or button in the TECNOWIN-I ToolBox:  ). The command asks 
for the objects that we want to change. There is only one object in our case. We put on Q1-Q2 
and pick. A Dialogue Frame with the existing layers appears. We click on the new layer for our 
object. We select the OTHERLAYER Layer. 

              We already have the Q1-Q2 line belonging to the new OTHERLAYER Layer, meanwhile 
V1-V5 belongs to the TW Layer. On the other hand we selected the OTHERLAYER Layer as the
current working layer. Next lines will belong to OTHERLAYER Layer and will be drawn in 
RED color.

            The next step consists in moving the V1-V5 polygonal from the V1 point to the middle 
point of Q1-Q2. We pick the MOVE command (Edit Menu, or button in the TECNOWIN-I 
ToolBox).
            First the application asks for SELECT objects for moving. The cursor appears in the 

Select Mode    .    We put the sight on the lines objects V1-V2, V2-V3, V3-V4 and V4-V5 
and pick one after the other. Well see that theyll appear in DASHDOT mode showing they are 
SELECTED (NOTE.- If we pick over the same object again, itll be NO SELECTED for the 
operation    (MOVE in this case) and it becomes in CONTINUOUS mode again.
        When weve selected all our objects pick the right button of the mouse to let TECNOWIN 
notice that the SELECT process is finished. (NOTE.- For seeing how we can select objects by 
the WINDOW / CAPTURE  methods please read the Manual or the Questions / Answers 



chapter).
    After this process, the application asks for the first point for moving From point:. 
 We pick the ENDPOINT command and we move the sight until V1 is into the sight, picking in 
that moment. The phrase To point: appears in panel. We pick another support command that is 
close to the ENDPOINT command: MIDPOINT and we move the cursor/sight until it is over 
Q1-Q2, (Never mind if we are near Q1 or near Q2) and well pick.    If the operation is right the 
V1-V5 polygonal moves until V1 point coincide with the Q1-Q2 midpoint.

            To end with this Tutorial chapter were going to work with the TW layer and then were 
going to hide the OTHERLAYER Layer.
            For TW becoming to the CURRENT WORKING LAYER (current layer) again we pick 
the CURRENT LAYER command (Status Menu, Layers Submenu or button in the Up ToolBox).
A layer listing appears. There are two layers in our drawing: TW and OTHERLAYER. The 
current working layer appears signed on by default (OTHERLAYER in our case) . We select as 
new current working layer TW and pick OK. Then the TW Layer must appear in the right lower 
panel as the Current Working Layer.

        Next we pick the LAYERS ON/OFF command (Status Menu, Layers Submenu or button in 
the Up ToolBox). A Dialogue Frame with two list appears. In one side are the layers ON 
(Visible). On the other side are the layers OFF (Hide) . We select the OTHERLAYER Layer and 
pick the button for passing ON->OFF the layer.
        We pick OK and well see in the screen that Q1-Q2 disappears. Is Q1-Q2 erased? Not. Q1-
Q2 belongs to a hide layer.
          We have finished this chapter, well print our drawing (in its current state) in the next 
chapter.



 Printing

 Its time for printing our work. There are three commands in relation with this subject:

          PRINTER SETUP    (File Menu): Permits to choose the printing device. We can change 
the printing device from the Dialogue Frame of the PRINTING command too.

          PRINTING    PREVIEW (File Menu, button in Up ToolBox     ): Permits to make a  
preview view of our job before printing it .
 

          PRINTING  (File Menu, button in Up ToolBox  ): Permits print out the drawing. 

      The PRINTING PREVIEW and PRINTING are similar. The only difference is that 
Preview assumes all default printing device characteristics, including paper size. Then the 
Printing Dialogue Frame does not appear. Therefore all things well say about the Printing 
command can be applicable to the Printing Preview command. The Preview advantage is that we
can test the paper size, scale and drawing position in paper before printing out.

      When we pick the Printing command the application asks for the lower left point (P1) of our 
drawing. This point will coincide with the lower left point of the paper. So this is the 
fundamental point to put our drawing into the paper. When we pick this point TECNOWIN 
asks for another point: the up right point (P2) of our drawing (or piece of drawing ). This point 
is only a reference point to define the printing area. The point position in the paper will be 
determinate in function of the Scale and paper size.
    You can see the P1 and P2 points in the previous drawing.
    

Next appears a Dialogue Frame asking for the drawing Scale (1/100 by default). The 1/ come 
built in the Dialogue.    We must type the denominator (For example: 50 for 1/50, 100 for 1/100, 
200 for 1/200). A 1/100 Scale means 1 meter of our drawing will be equal 1 cm. in the printing 
paper . A 1/50 Scale means 1 meter of our drawing will be equal 2 cm. in printing paper. A 1/200 
Scale means 1 meter of our drawing will be equal 0.5 cm. in printing paper.
      There is very IMPORTANT fact.  There is a text lower the Scale Fit Scale to Paper Size and 



its marked by default. It means that if we let the mark on (default value) TECNOWIN will fit 
the drawing scale for viewing the drawing making the most of the paper, although we put a Scale
factor in the dialogue. So if we want to print at Scale we must:
 a) Type the Scale (If different of 1/100).
b) Deactivate the mark in Fit Scale to Paper Size (Format).
        Weve chosen 1/50 for printing in A4 size.
          Finally, the Printing Dialogue Frame appears. We can change the printing device and/or 
the paper size here.



Questions and Answers

·  General Questions and Answers
·  Questions and answers to AUTOCAD[*] users

(*) AUTOCAD is a trademark of AUTODESK, Inc.



 General Questions and Answers

    * I usually worked with other CAD application, and Id like to pass TECNOWIN, but ... Can I 
pass my drawing files to TECNOWIN format ?

      TECNOWIN files have got    .tnt    format. This is the default format for TECNOWIN files. 
But your drawing files format DONT MATTER if your program accepts DXF export because 
TECNOWIN can read / write DXF files.
 Please read the DXF READ command in the TECNOWIN help file.

      * Id like work with TECNOWIN, but I    usually work with people that have another CAD 
program. Can we interchange information in any mode ?

          Yes, if your CAD program permits import / export files in DXF format, because 
TECNOWIN reads and writes files in DXF format.

    * Does TECNOWIN have any limitation about files size?

    NO. The only limitation is imposed by your computer limitation.

      * My drawing does not fit in the default TECNOWIN drawing area. How can I extend my 
working area?

        Use the ZOOM SCALE command. If you enter in the Dialogue Frame a scale factor of 1, 
your drawing area remains unchanged. If you enter a scale factor of    2, your drawing area 
becomes to a double area in relation (X,Y) with your previous area. If you enter a scale factor 
less than 1 it will decrease. For example a 0.5 factor brings near your drawing. Your working 
area (in units) will be smaller than your previous working area.

      *    What is the Aerial View advantage ?    Can I have more than one?

    The Aerial View permits viewing in a separate window all the drawing so that we can do 
ZOOMS WINDOW in dynamic mode, I    mean, we pick two points in the Aerial View and well 
see the corresponding ZOOM in the main window.
    You can only have one Aerial View for drawing.

      *    How can I close an Aerial View?

Closing its window like another Windows window.

      * How many 3D views can I    have ?

 You can have as many as you want. Anyway the maximum cameras number is SIX. So the 
different 3D views you can have is SIX.



        * Can I    have some Section Views at the same time?

    Yes. You have not limitation.

        *    Ive read the Tutorial but I dont    know how to SELECT some objects at the same time 
instead of picking one after the other. Can you explain it?

        Of course. When the application asks for objects to apply a command (usually an Edit 
command like erase, move, copy, extend, fillet, mirror...) a sight cursor appears. If we put the 
cursor on the object and pick, it will be selected (dashed). If we pick over a selected object again,
the object will be discarded for the group of selected objects (continuous). We already talked 
about it in the Tutorial. But if we must select 5,10,20, or 1000 objects the more affordable mode 
is with the WINDOW SELECT o CAPTURE SELECT. We can see in the figure the way for 
picking P1 and then P2 for WINDOW SELECT and the way for picking Q1 and then Q2 for 
CAPTURE SELECT. In the first case all the objects fully included into the window are selected. 
We see there are two line objects not fully included into the Window defined by P1 and P2 and 
theyre not selected. In the second case all the objects fully or partially included into the Window 
defined by Q1 and Q2 are included. 
      How does TECNOWIN understand that the P1-P2 Window corresponds with a SELECT 
method of WINDOW and the Q1-Q2 Window corresponds with a SELECT method of 
CAPTURE ? Theres nothing better than an example: 

You can see how we pick P1 then P2 and how we pick Q1 then Q2. In the first case weve opened
a window to the up/right direction (P2 is up/right from P1). TECNOWIN assumes that we want 
to make a WINDOW SELECT . In the second case weve opened a window to the down/left 
direction and TECNOWIN assumes that we want to make a CAPTURE SELECT.

          * The solid raster hatch is easy to use, but Ive seen two problems:
    a) It must be inside an enclosure, but it extends sometimes to another zones depending of the 
current ZOOM.
    b) Its not printed in my printer.

      a) You are right. It can be possible though the hatch has got a defined boundary, specially if 
we do a large ZOOM (a ZOOM with a large Scale). In that case the hatch can escape to 
adjoining zones. The reason is that the hatch extends until it finds a physical boundary, and the 
boundary can be wrong delimited in ZOOMS with large scale. This fact depends of the screen 
resolution as well. Youll find less problems if youve got a graphics card with higher resolution. 
However you must not find that problem in printing (if your printer/plotter supports raster 
display mode. We talk about it next). 
    
      b)    Your printer does not support raster-display technology and it can not print this type of 
hatches. Therere not much devices that support this technology at this moment.



            In short: We recommend youve got the solid raster hatch limitations on your mind and you
operate with raster hatches type Region. Youll get the same effects with them without problems. 
Youll only need a little more effort.

 
      * The  3D Menu is not accessible when I open a 3D Window. What can I do ?

      Yes, you are right. You must pick in any internal point of the window for activating the Menu.



 Questions and Answers for AUTOCAD [*] Users
(*) AUTOCAD is a trademark of AUTODESK, Inc.

  * Can I pass my drawing from / to AUTOCAD from / to TECNOWIN?

      Yes, because TECNOWIN either reads and writes files in DXF format. Please read the 
commentary about it in the General Questions and Answers chapter.

      * I work with AUTOCAD for WINDOWS. Is there another way for sharing my information 
with TECNOWIN?

    Yes, because both of them support OLE. TECNOWIN supports OLE 2.0 in two ways: Server 
and    Container. It means you can either call an AUTOCAD file from TECNOWIN or call a 
TECNOWIN file from AUTOCAD.

        * I usually type the Absolute Coordinates / Polar Coordinates with AUTOCAD. Can I do the 
same thing with TECNOWIN?

 Yes. TECNOWIN supports the following formats for entering points by keyboard:

                                                      X,Y      for Absolute Co-ordinates. Example: 4,2
                                                      @ x,y        for Polar Co-ordinates x,y. Example: @ 4,2
                                                      @ d<a      for Polar Coordinates distance/angle. Example: @ 4<90

    You must keep in mind that you must pick the RIGHT BUTTON of the mouse for ENTER 
(The ENTER key of the keyboard will not work).

    Anyway we suggest you read the Tutorial (My First Drawing chapter) . Youll can see another 
ways for entering point coordinates and point positions in TECNOWIN.

            *    There are not FREEZE / THAW layers in TECNOWIN.

        You are right. AUTOCAD(*) uses the freeze / thaw layers for earning in speed    in some 
ZOOMS, but it can be pretty confuse for new users. TECNOWIN has got its own way    for 
handling this subject. It only handles ON / OFF layers for simplicity.

            *      Is there any limitation in the number of layers?
        NO.



            * I dont find the only Dialogue Frame for Layers.

        Right. There is not only one. There are Dialogue Frames for: New Layer, Current Layer and 
ON / OFF Layers.

              
          * When I do a ZOOM-EXTENTS in AUTOCAD the drawing extends along the screen and
I have not margins for working.    Is there any possibility in TECNOWIN?

      Yes. Weve incorporated the MARGINS command (Status Menu) that fits lateral margins (in 
meters) when you make a ZOOM EXTENTS.

            * Can I purge Blocks / Layers in any moment in my drawing ?

      YES. You can see the Purge Blocks / Purge Layers commands.

            *    Can I make my own library and put my icons?

    Thats not necessary. When you do a Directory Preview command (we also call this command 
Library Preview) of the drawings in a directory TECNOWIN updates the files information and 
youll see all and each one blocks.

              *    Can I open several drawings at the same time ?

 YES. TECNOWIN is MultiDocument. You can arrange the views in Cascade / Tile mode.    You
can have any views of the same drawing too.

            *    How can    I    close a polyline ?

 You must use the Close Polyline command (Edit Menu, Edit Polyline Submenu).

(*) AUTOCAD is a trademark of AUTODESK, Inc.






